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General Ledger Transaction Entry

The General Ledger Transaction Entry screen allows you to enter transactions or journal entries to be posted
to the General Ledger. The Transaction Entry screen can be customized to include only the fields needed
when inputting journal entries. Files can also be uploaded to General Ledger through this function. 

The Transaction Entry screen operates within CIM GOLD under the Financial Applications menu in the left
tree navigation, as shown below.

Features

If you are familiar with the FPS GOLD Accounting system, you may already know that you can post
transactions in the General Ledger system in GOLDVision and in G/L GOLD. The ability to post G/L
transactions in CIM GOLD helps your institution successfully track debits and credits in your General
Ledger accounts.

The benefits of posting transactions in CIM GOLD include:

· Fast processing

· Pre-validation performed on local machine prior to sending to host computer for processing

· Quick access to Chart of Accounts

· Import files in several formats, including directly from Excel

· Robust transaction filtering capabilities

· Configurations stored in a common-access database

Security must be set up for all employees at your institution who will be using this screen. For more
information on security, see Setting Up Security.

https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl.htm
https://secure.fps-gold.com/docsOnWeb/uguides/GLGOLD/ugl5s10.htm
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Setting Up Security
Setting up security to use the General Ledger Transaction Entry screen requires three steps:

1. Each institution will need to use the Subscribe to Mini-Applications screen to enable the Transaction
Entry screen to be shown in the CIM GOLD tree. This is only done once. The Subscribe to Mini-
Applications screen is accessed under Security in the left tree in CIM GOLD. If you have security
clearance, check the box next to Transaction Entry, as shown below:

Security > Subscribe to Mini-Applications Screen in CIM GOLD

2. Next, CIM GOLD security needs to be added to each employee or profile that will be using the

Transaction Entry screen. This allows the user to access the screen from the CIM GOLD navigation

tree. Use the Security > Setup screen, CIM GOLD tab to set up individual users. You can give them

inquiry access or file maintenance access to this screen, as shown below:
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Security > Setup Screen, CIM GOLD Tab

3. Each user must still have security to the General Ledger application under the Security > Setup screen,
System tab. The user will be able to backdate or post transactions according to their System security
setup. See the example below:
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Security > Setup Screen, System Tab
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Control Group Entry
When you first access the Transaction Entry screen or click the <Control Group Entry> button, the Control
Group Entry dialog box is displayed (see below). All fields must be completed on this dialog box in order to
proceed to the Transaction Entry screen. Click <OK> after completing the fields and they will be displayed on
the Transaction Entry screen.

Field Description

Control Group This is the control group that the transactions will be posted to. A warning will
pop up if the control group you enter is reserved for FPS GOLD. A warning will
also be displayed if this control group already exists. Any number up to 8-digits
long can be entered, except those numbers reserved for FPS GOLD.

A list of current FPS GOLD-reserved control groups can be found in DocsOnWeb
under Other > GOLDServices > Appendix E. The majority of these reserved
control groups follow a simple date format (MMDDYYYY), followed by two digits
between 00 and 40.

Description Enter a user-defined description for the control group in this field. The description
should be descriptive of the type of entries for these transactions, such as
monthly checks, journal entries, accounts payable, etc. This description will be
saved as the transaction description when the transactions are posted, unless
manually overwritten when entering transactions on the Transaction Entry
screen.

Source Code The source code is user-defined. Source codes are used as search parameters
for retrieving transactions for correction, review, deletion, etc. You can also enter
a code to refer back to the description entered in the Description field. For
example, if you entered "Monthly Checks" in the Description field, you could
enter "C" as the source code for checks.

The source code you enter here will be saved as the source code when
transactions are entered on the Transaction Entry screen, unless you manually
overwrite it.

https://secure.fps-gold.com/docsOnWeb/other/GOLDServices/ogse.htm
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Field Description

Effective Date This is the effective date for the control group and will default based on your
institution’s options and the current accounting period as set up on the Company
Options screen (function 2) in the General Ledger system. If the option is set to
default the effective date to today and the current accounting period entered in
Company Options matches the calendar month, then the effective date will
default to the current date. If the current accounting period does not match the
calendar month, the effective date will default to the last day of the current
accounting period. So, for example, if the current date is October 28 and the
current accounting period entered in Company Options is set to September, the
default effective date for your control group will be September 30.

In addition, if the option is set to "Yes" to warn the user if the effective date is not
today, then a warning will be displayed if the effective date does not equal the
current date. An additional warning will also be displayed if the effective date is
not in the current accounting period.

The date entered in this field will be the effective date of the transactions entered
on the Transaction Entry screen, unless you manually overwrite the effective
date. (You will need to add the Effective Date field to the Transaction Entry
screen through the <Configurations> button.) 

Post Reversing Entry to
Next Accounting
Period

This box controls whether or not reversing entries are posted to the next
accounting period. If this box is checked, reversing entries will be posted to the
next accounting period. 

All signs in the batch created in the next fiscal month are reversed on each line
item, and the literal, "-RVS", is added to the end of your transaction
descriptions. For example, the description "TEST" would become "TEST-RVS."
Leave this box blank if you do not want to create a posting to the next period.

NOTE

When posting transactions in the General Ledger, the system
checks the Maximum Future Days field on the  Company
Options screen before processing. 

The Maximum Future Days field allows you to set a date
restriction for the effective date on your control group or
transactions. If the difference between the current date and the
Effective Date you entered is greater than the number of days
allowable in the Maximum Future Days field, the following
error appears: "Invalid MAX FUTURE DAYS range selected."

After you have completed the entries on the Control Group Entry screen, click <OK>. The Transaction Entry
screen is displayed. This screen allows you to input data according to the various fields you establish when
you configured the screen (see Configurations for more information). To enter transactions on the
Transaction Entry screen, enter the information requested by each field. Each Transaction Entry screen
must have the following fields:

https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl3s2.htm
https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl3s2.htm
https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl3s2.htm
https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl3s2.htm


General Ledger Transaction Entry 9

© 2025 FPS GOLD. All rights reserved. Last updated: 11/12/2025

· All account number sub-fields that have been used
· Amount field

For more information concerning each of the fields you can use, see Customizing the Transaction Entry
Screen.

You can manually enter information in each of the fields, or you can import transactions that will be loaded
automatically onto this screen. Once all transactions are listed, post the batch of transactions to their
designated accounts.
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Configurations
Before you can start entering and posting G/L transactions, you need to set up the Transaction Entry
screen with specific fields you want included with the transactions. Clicking the <Configurations> button on
the Transaction Entry screen allows you to set up specific fields for different configurations you set up.

You can set up as many configurations as you need. Once a configuration is set up, you can use the it
each time you access the Transaction Entry screen by selecting it from the drop-down list, as shown below:

Once you select the configuration from the drop-down list, the fields on the Transaction Entry screen will
change accordingly.
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Customizing the Transaction Entry Screen

To set up new configurations:

1. On the Transaction Entry screen, click <Configurations>.

The Configurations screen is displayed, as shown below:

2. Click <Create New>.

3. In the Name field in the Configuration Settings box, enter a descriptive name for this configuration. 

For example, if this configuration is for monthend journal entries, you could enter "Monthend Journal
Entries." If the configuration is for check entries, you could enter "Check Entries." Be descriptive
enough that others working on the screen will understand which configuration is for which type of
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transactions. What you save here can be seen by all users of CIM GOLD at your institution. This is a
required field.

4. Enter a description for the configuration in the Description field. This field is optional. 

5. The Owner field will be entered with your user name. You can change the name in this field if
necessary.

6. In the Field list view, check the box next to each of the fields you want displayed on the Transaction
Entry screen. 

These are the fields where users enter transaction information. 

Possible choices are:

Field Description

ACCOUNT, BRANCH,
SUBACC

Select all available account subfields. See your account number structure for
more information. 

ACCOUNT, BRANCH,
SUBACC (DR) (CR)

(Debit/Credit Accounts)

If the first account fields (ACCOUNT, BRANCH, SUBACC) are used, the
credit and debit account fields cannot be used, and vice versa.

If the configuration you are using is set up with the debit and credit accounts,
you will only need to enter one amount, and the system will duplicate the
amounts into the separate debit and credit accounts, as shown in the
following example:

Field Description

Amount This is the amount of the transaction. This amount can be either positive
or negative, depending on which type of account you have selected (see
definitions above). 

For example:

· If you have selected the Debit Accounts, the amount entered in this
field would automatically be positive. 

https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl3s3.htm
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Field Description

· If you selected the Credit Accounts, the amount entered would
automatically be negative. 

· If you entered the Debit/Credit Accounts, you must manually enter
the negative sign to the amount to indicate that it is a credit.

This field is mandatory, so this box should always be checked on all
configuration setups.

Description Check this box if you want to include a description with the transaction
you are entering or importing.

Reference Number Check this box to include the Reference Number field on the
Transaction Entry screen. The reference number is a user-defined field.

Source Code Check this box to include the Source Code field on the Transaction Entry
screen. The source code is user-defined. Source codes are used as
search parameters for retrieving transactions for correction, review,
deletion, etc. You can also enter a code to refer back to the description
entered in the Description field. For example, if you entered "Monthly
Checks" in the Description field, you could enter "C" as the source code
for checks.

Effective Date Check this box to include the Effective Date field on the Transaction
Entry screen. The Effective Date entered must match the accounting
period you are posting transactions to, or you will receive an error
message.

Payee Check this box to include the Payee field on the Transaction Entry
screen. This field allows you to enter a payee associated with
transactions. 

Quantity Check this box to include the Quantity field on the Transaction Entry
screen. The Quantity and Standard Unit Quantity fields are used for
entering statistical data. 

Standard Unit Quantity Check this box to include the Standard Unit Quantity field on the
Transaction Entry screen.

The Quantity and Standard Unit Quantity fields are used for entering
statistical data. 

Distribution Profile If you check this box, the Distribution Profile field displays on the
Transaction Entry screen. This field is a drop-down field, and displays all
distribution profiles previously set up previously on the Distribution Profile
screen (function 87/88). Distribution profiles allow you to enter one
transaction on this screen and have the system distribute that
transaction between several accounts as set up in the distribution
profile. 

For example, if your institution hires a custodial service to clean five of
your branches, you can distribute the monthly cost of the custodial
service. Rather than manually splitting the cost and entering five

https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl8s5.htm
https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl8s5.htm
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Field Description

transactions for each branch's portion of the cost, set up a distribution
profile.

Branch Allocation
Table

Check this box to include the Branch Allocation Table field on the
Transaction Entry screen. The field appears as a drop-down list, on the
Transaction Entry screen, and only Branch Allocation Tables that you
have set up on the General Ledger Branch Allocation screen (function 92)
will be displayed in the drop-down list.

Account Title - Long Check this box if you want to include an Account Title - Long field on
the Transaction Entry screen. This field is for display purposes only; file
maintenance is not allowed.

Account Title - Short Check this box if you want to include an Account Title - Short field on
the Transaction Entry screen. This field is for display purposes only; file
maintenance is not allowed.

7. When importing transactions, double-click the number in the Import Column and change the number of
the column where that field should be displayed on the Transaction Entry screen. The column number
entered here should match the column number in the file you are importing.

You can easily change the position of the fields on the Transaction Entry screen if you later need to
change the order of the fields. Once on the Transaction Entry screen, just drag and drop the column
headings in the order you prefer.

8. Click <Save>. The configuration setup will be saved in the drop-down list on the Transaction Entry
screen.

To update a previously saved configuration:

1. On the Configurations screen, select the configuration you want to edit from the top list view.

The details of that configuration will be displayed in the Configuration Settings box.

2. Change the Name, Description, Owner, and any of the fields for this configuration, as needed. For
information on definitions of each of the fields in the list view, see the Field list view description in the
steps above.

3. Click <Save>.

To copy configurations:

1. On the Configurations screen, select the configuration you want to copy from the top list view.

The details of that configuration will be displayed in the Configuration Settings box.

2. Click <Copy>.

The Name of the configuration will change to display the word "Copy" after it (as shown below). You
can change this name to something else.

https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl8s6.htm
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3. Make any additional changes to the Description, Owner, and any of the fields for this configuration, as
needed. For information on definitions of each of the fields in the list view, see the Field list view
description.

4. Click <Save>.

To delete configurations:

1. On the Configurations screen, select the configuration you want to delete from the top list view.

The details of that configuration will be displayed in the Configuration Settings box.

2. Click <Delete>.

The following message will be displayed:

3. Click <Yes> and the configuration will be deleted.
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Transaction Entry Screen Details
The Transaction Entry screen is used to enter transaction information that you want to post to the General
Ledger. This screen is found under Financial Applications > General Ledger > Transaction Entry in CIM
GOLD.

The following is an example of the Transaction Entry screen, followed by descriptions of each of the fields. 

# Field Description

1 <Control Group
Entry>

Click this button to display the Control Group Entry dialog box where you
can enter a new or existing control group to post transactions to.

2 <Chart of Accounts> Click this button to open the Chart of Accounts screen. This screen lists all
General Ledger account numbers that have been set up in the General
Ledger system. For more information, see Chart of Accounts.

3 <Clear Grid View> Click this button to clear all the transactions entered or imported in the grid
view on the Pending Items tab. You will be prompted to confirm the deletion.

4 <Import> Click this button to import a file of transaction information that you have
saved somewhere else on your computer or network. For more information on
importing transactions, see Importing Transactions.

5 <Post Batch> Click this button to post the batch of transactions you have entered, either
manually or by importing a file. Transactions cannot be posted until all error
messages are corrected. Error messages appear in the Status column,
described below. Once transactions are successfully posted, they will be
displayed on the Posted Items tab. For steps on how to post transactions,
see Posting G/L Transactions.
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6 Branch You can type a branch number in this field, and when you enter information
for the transaction, the system will automatically insert the branch in the
designated column. You can type over the branch number in the Fields
section once it's been inserted.

7 Control Group This is the control group of this batch of transactions. The control group is
also referred to as the batch number. If the batch number is posted in a
different period than the effective date, you may receive an error or warning in
the Status column. For more information on how to correct errors, see
Common Errors.

This field is not file maintainable once it has been entered on the Control
Group Entry dialog box. The Control Group Entry dialog box is displayed
when you first access the Transaction Entry screen or when you click on the
<Control Group Entry> button.

8 Effective Date This is the effective date for the control group. The date you enter here will be
the effective date of the transactions entered on the General Ledger
Transaction Entry screen, unless you manually overwrite the effective date.
(You will need to add the Effective Date field to the Transaction Entry
screen through the <Configurations> button.) A warning will be displayed if
the effective date is not in the current period.

This field is not file maintainable once it has been entered on the Control
Group Entry dialog box. The Control Group Entry dialog box is displayed
when you first access the Transaction Entry screen or when you click on the
<Control Group Entry> button.

9 Source Code The source code is user-defined. Source codes are used as search
parameters for retrieving transactions for correction, review, deletion, etc. You
can also enter a code to refer back to the description entered in the
Description field. For example, if you entered "Monthly Checks" in the
Description field, you could enter "C" as the source code for checks.

The source code displayed here will be the source code when transactions
are manually entered on the Transaction Entry screen, unless you overwrite
it.

This field is not file maintainable once it has been entered on the Control
Group Entry dialog box. The Control Group Entry dialog box is displayed
when you first access the Transaction Entry screen or when you click on the
<Control Group Entry> button.

10 Description This field displays the description of the batch, as entered in the Control
Group field on the Control Group Entry dialog when you first access the
Transaction Entry screen or when you click on the <Control Group Entry>
button. The description can be anything you want, but it should be
descriptive of the type of entries for these transactions, such as monthly
checks, journal entries, accounts payable, etc. 

This description will be saved as the transaction description when the
transactions are posted, unless you manually overwrite the description for
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the transactions when manually entering transactions on the Transaction
Entry screen.

11 Configuration drop-
down

The Configuration drop-down field displays all configurations that are
currently set up for your institution (or client number). Select a configuration
from this drop-down list, and the fields in the list view on the Transaction
Entry screen will change according to how the configuration is set up. See
<Configurations> definition below.

12  <Configurations> Click this button to access the Configurations screen, which allows you to
add, edit, and delete configurations. Configurations are used to customize
the Transaction Entry screen.

13 Filters Click the Filter arrow to expand the Filters box. This box enables you to
search for specific information in a batch. This tool is especially useful if
you've imported a large file of transactions and need to make changes to one
or two. For more information, see Filters.

14 Diamond Clicking the diamond indicator allows you to copy a row, field, or fields from
the diamond row to another row, field, or fields on another row.  This is
accomplished as follows: 

1. Click the diamond on the row to be "copied from."  
2. Select (highlight) a row, field, or fields on the row to "copy to."  
3. Press the duplicate key ("*" on the 10-key pad).

15 Status If any errors or warnings exist for the transaction information you entered or

imported, this column will display a warning  or error icon . You cannot
post items with errors. For more information on how to correct errors and
warnings, see Common Errors.

16 Fields The columns to the right of the Status column are the fields you will use to
enter or import your transaction information. To set up which fields are
displayed here, select the configuration from the Configuration drop-down
list, or click <Configurations> to set up a new configuration. See the
descriptions above.

You can either manually enter information in these fields, or you can import
information from a file or spreadsheet you have saved on your computer or
network. Pressing <Enter> when you are finished typing information on one
line will take you to the next line.

 TIP: If you manually enter information as well as import information,

and the sequence numbers are out of order, right-click the list
view and select "Resequence" to renumber the items in the list
view.

17 Row Section Clicking this row field will select (highlight) the entire transaction line
(row). Use <Ctrl> + C to copy this row and <Ctrl> + V to paste this row as a
new row. You can also duplicate the selected row directly above the current
transaction entry line by pressing the "*" on the 10-key pad.
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18 Totals At the bottom of the Transaction Entry screen are the Batch Totals and
Control Group Totals. 

The Batch Totals display the number of transactions currently entered in the
batch, the total debits and credits for the batch, and the net difference
between the credit and debit amounts. The batch does not need to have a
net difference of zero, but a warning message will be displayed if you click
<Post> when a net difference other than zero does exist. You can ignore this
warning if you are sure you want to post the batch.

The Control Group Totals shows totals for all the batches you have posted
for this day with the same control group. You can post more than one batch
in a day, and the Control Group Totals will display the totals of all debits,
credits, and any net differences of all the batches for that date, using the
control group number displayed at the top-right of the screen.

19 Duplicate Key The duplicate key is the asterisk ("*"). It can used to copy the cell above, or
the cell in the row selected with the diamond indicator, to a selected cell. It
can also be used to copy cells above, or cells on a row selected with the
diamond indicator, to a selection of active cells.
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Posting G/L Transactions

The following information describes the general steps you will take to post transactions to the General
Ledger using the Transaction Entry screen in CIM GOLD.

To post G/L transactions:

1. Access the Transaction Entry screen in CIM GOLD (Financial Applications > General Ledger >
Transaction Entry).

The Control Group Entry dialog box is displayed.

2. Enter the information in the fields on the Control Group Entry dialog box. 

3. Click <OK>. 

The system will take you to the Transaction Entry screen, and the information you entered in the
Control Group Entry will be displayed in the top group box, as shown below:
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4. Select the configuration you want to use for this batch of transactions from the Configurations drop-
down list. If you want to create a new configuration, click <Configurations>. For more information on
setting up configurations, see Configurations.

5. If you are importing a file, click <Import>. 

The Transaction Import dialog box will be displayed. Use this dialog to enter the information of the file
you are importing. See Importing Transactions for more information.

-OR-

If you are manually entering transaction information, you would type the information in the designated
fields on the Transaction Entry screen, as shown below. Any error messages will be displayed under
the Status column. See Manually Entering Transactions for more information.

6. Fix or correct any errors or warnings that may be displayed.

C TIP: See Common Errors for a list of common errors and how to correct them.

7. Click <Post Batch>. 

A warning message will display requesting confirmation to proceed. If you click <Yes>, the transactions
will be batched up in groups of 500 (if applicable) to be sent and processed on the host. Once
completed, the transactions will be moved from the Pending Items tab to the Posted Items tab. Failed
transactions (if any) will remain on the Pending Items tab.

NOTE 

A message is included with the warning message if the batch does not have a net
total of 0.00, as shown below:
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You can still post the batch. Accounting best practices generally dictate that General
Ledger transaction batches net 0.00, but there may be exceptions.

You can also include the account fields for debit and credit right next to each other on
the Transaction Entry screen, and anytime you enter an amount, the amount is
automatically duplicated into credit and debit accounts. For more information on
these fields, see Customizing the Transaction Entry Screen.

Once transactions have been posted to the General Ledger from CIM GOLD, you can view a report of the
transactions by running the Control Group Entry Detail Report on the  Control Group Entry screen (function
20, then report 1) in GOLDVision. 

If you need to make any further changes to the transactions that were posted, access the Transaction
Display or Correction screen (function 12) in the General Ledger system in GOLDVision and make changes
there.

To save a record of the posted transactions or to print a copy of the posted transactions, access the Posted
Items tab, right-click on the list view, and select the appropriate menu items you want to use. For more
information, see Posted Items tab.

Manually Entering Transactions

You can manually enter transaction information directly onto the Transaction Entry screen, and then post
those transactions to the host computer. The following steps describe how to manually enter transaction
information onto the Transaction Entry screen.

To manually enter transactions:

1. After accessing the Transaction Entry screen and entering the control group entry information, select
the configuration you want to use for this batch of transactions from the Configurations drop-down list.
If you want to create a new configuration, click <Configurations>. For more information on setting up
configurations, see Configurations. The fields on the Transaction Entry screen will change according to
which configuration you choose.

2. Place your cursor in the first field (after Status) and enter the relevant data, as shown below: 

You can also quickly enter account information by completing the following steps:

1. Click <Chart of Accounts> at the top of the Transaction Entry screen.

https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl6s1.htm
https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl4s5.htm
https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl4s5.htm
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2. Double-click the G/L account in the list that you want this transaction to go.
3. The G/L account you selected will be displayed in the next entry on the Transaction Entry screen.
4. Change any of the fields for the account number for this transaction. (For example, change the

Amount field from the default of "0.00" to the amount of the transaction.)

3. For the Amount field, you can enter a negative sign (-) if the amount is a credit. The negative sign can
go before or after the amount, such as "-250.00" or "250.00-". When an amount has been entered
including two decimal places (e.g., 500.00), the cursor will automatically tab to the next field.

Note: If the configuration you are using is set up with the debit and credit accounts, you will only need
to enter one amount, and the system will duplicate the amounts into the separate debit and credit
accounts. See the Field list view description in the Customizing the Transactions Entry Screen section.

4. Click the Status field and correct any errors that are displayed for that line of information. Errors are

displayed with a red icon , and must be corrected before posting. Transactions with a yellow warning

indicator  can still be posted. 

5. When all transactions have been entered correctly, you can post the transactions to the host computer.

Importing Transactions

Some institutions have a system in which someone enters General Ledger transaction information into an
Excel spreadsheet or other document. Using the Transaction Entry screen, you can import that
spreadsheet or document and post the transactions to the FPS GOLD host computer.

NOTE 

Your spreadsheet or document does not need to be in the exact format as your
configuration setup before you can import it into CIM GOLD. The Configurations
screen allows you to designate which column in the import file corresponds with
which field on your configurations. See Configurations for more information.

The following steps describe how to import transaction information you have saved in a file.

To import transactions:

1. After accessing the Transaction Entry screen and entering the control group entry information, select
the configuration you want to use for this batch of transactions from the Configurations drop-down list.
If you want to create a new configuration, click <Configurations>. 

For more information on setting up configurations, see Configurations.

2. Click <Import>.

The Transaction Import dialog box is displayed, as shown below:
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3. Select the configuration you want to use from the Configuration drop-down list. For more information
concerning configurations, see Configurations.

4. Click the browse icon to find  and select the file where your transactions are saved. When you
double-click on the file, it will automatically be placed in the File Path field. If you are using an Excel
file (extension is .xls or .xlsx), the system will automatically extract the worksheet information, and you
will need to select which worksheet you want to import (see step 5 below).

5. In the Field Delimiter box, select how each column of information is separated. The columns can be
separated by a Tab, a Semicolon, a Comma, a Custom separator, or you can import an Excel file. 
· If you use a custom way of separating information (such as a backslash (\) or asterisk (*)), you

need to enter the custom separator in the field to the right of the Custom field.
· If you are importing an Excel file, you need to specify which sheet the data you are importing is

found on. Only one sheet can be imported at a time.

6. If the data you are importing includes a header line, check the Remove Header Line box. The header
line is the first line that has a header name at the top, such as "Account Number, Amount, etc." The
system will import the header line but will be marked with an error status.

7. If the data you are importing includes quotation marks, check the Remove Quotation Marks box.
Checking this box discards any extraneous quotation marks from the file. 

For example, when an Excel file is saved as a tab-delimited text file and some of the fields contain
punctuation (such as commas or apostrophes), Excel places quotation marks around that field. By
checking this box, all such quotation marks will be discarded from the file.

8. Check the Clear Grid Before Import box to clear any information from the Transaction Entry screen, if
previous information has already been entered on that screen. If you leave the box unchecked, the
information you are importing will be displayed below any information already entered on the Transaction
Entry screen.

9. Click <OK> to start importing the transactions from your file. The system will validate the data that is
being imported and error messages will be displayed if values from the spreadsheet cannot be imported
to a particular field or column on the grid view. For example, if your configuration has been set up to
map data from a particular column on your spreadsheet to the Amount field and the data in your



General Ledger Transaction Entry 25

© 2025 FPS GOLD. All rights reserved. Last updated: 11/12/2025

spreadsheet contains alphabetic characters instead of a numeric value, the import process will display
an error. 

The error message will note which row and column in your file the data is not able to be imported from. If
you want to stop the import, you can click on the <Cancel> button to stop uploading the file. As soon
as the import reaches a row in the file where the data in every column is blank, the upload will stop. If
you have blank rows in the middle of your spreadsheet, you will need to manually fix your file and delete
them before re-importing.

After the import process is completed, the transaction information you imported will be displayed on the
Transaction Entry screen in the configuration you selected. Any errors or warnings for any of the

transactions will be displayed in the Status field. Errors are displayed with a red icon , and must be

corrected before posting. For transactions with warning indicators , you can still post the
transactions even though a warning exists. Once you fix all errors with a red icon, you can then post the
transactions to the host.

Common Errors

When entering transaction information on the Transaction Entry screen, the Status column will notify you of
any errors for the data you entered. The following is a list of common errors and how to correct them. Yellow
errors are information only; they will not prohibit posting. Red errors will prohibit posting unless resolved.

  Transaction not posting to current period

A warning message is displayed on transactions not posting to the current period. To change the
period requires GOLDVision access to function 2 (Company Options screen) in the General Ledger
system. Under Current Account Period, set the current period in the Period Number field. For
more information on this option, see section 3.2, Company Options, in the General Ledger manual on
DocsOnWeb.

  Zero amount

If no amount is entered in the Amount field, you will receive this warning. You can update the
Amount field with an amount, or you can leave it as $0 and post the transaction. If an Amount field
is not displayed for this configuration, you need to add it. For more information about adding fields to
configurations, see Customizing the Transaction Entry Screen.

 Error determining COST center

This error displays if you have entered the wrong cost center (sub-field 3 of the account number
structure). The system could not find the account number with the cost center you entered. 

 Debit/Credit Account not on file

The account number you entered is not found in the Chart of Accounts. The problem may be that you
entered only part of the account structure wrong. Make sure each part of the account number
structure is entered correctly. If you think the account is entered correctly, try updating the Chart of
Accounts, or access the  General Ledger system directly and see if the account is indeed in the
General Ledger system.

https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl3s2.htm
https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl3s5s1.htm
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Posted Items tab

Once transactions have been successfully posted to the General Ledger using the Transaction Entry screen
in CIM GOLD, the Posted Items tab displays the transactions. These transactions cannot be changed from
this tab. If you need to make any further changes to the transactions that were posted, you would need to
access the Transaction Correction screen (function 12) in the General Ledger system in GOLDVision and
make changes there.

You can save a record of the posted items by right-clicking in the list view and selecting one of the following
Export options:

· Export to Report Manager: Exports the information in the list view to FPS GOLD's Report Manager
program.

· Export to Tab Delimited Text File: Exports the information to a text file with tabs as the delimiter
(spacer) between fields. You can open the file in any application you need. 

· Export to Excel: Exports the information to Microsoftâ Excel.

You can also print the posted items information by right-clicking in the list view and selecting one of the
Printing options.

The following is an example of the Posted Items tab:

https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl4s5.htm
https://secure.fps-gold.com/docsOnWeb/uguides/ReportManager/orm.htm
https://secure.fps-gold.com/docsOnWeb/uguides/ReportManager/orm.htm
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Chart of Accounts

Clicking <Chart of Accounts> on the Transaction Entry screen will bring up the Chart of Accounts screen.
This screen lists all General Ledger accounts that have been set up for your institution (and client number).
General Ledger accounts are set up on either the Single Account screen (function 53/54) or Multiple
Account screen (function 57/58). Note: The <Chart of Accounts> button will be disabled if no configurations
have been set up and selected on the Transaction Entry screen.

The following is an example of this screen.

If you want to export the Chart of Accounts to Excel, highlight the entire grid view on the Chart of Accounts
screen by pressing <Ctrl> + A on your keyboard. Then right-click and choose "Export Selected Rows to
Excel." Specify a filename on the Save As dialog box and then click <Save>, and the Chart of Accounts
details will open automatically in Excel.

You can search for the account you need in the following ways:

1. In the Text field in the Search Parameters box, enter either a number or part of the description for the
account number you want to use. For example, if you knew the word "MISC" was in the title, you
would enter "MISC" in the Text field. All accounts with the word "MISC" in the Account Description
(either Long or Short) will be displayed in the list.

2. Right-click in the list view and select "Find." 

https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl3s5s1.htm
https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl3s5s2.htm
https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl3s5s2.htm
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The Find dialog box is displayed (as shown below). 

1. Enter the text or number you are searching for in the Find field.
2. Click <Find>. Any matching account numbers will be displayed in the list view. 
3. Double-click the account number from the list view, and the Find dialog box will close and the

account number you selected will be highlighted on the Chart of Accounts screen.

3. If you know you only want to view active accounts, select the Active radio button in the Display box.
Only active accounts will be displayed in the account list, and all inactive accounts will disappear.
Note: The system only allows you to post transactions to active G/L accounts. When displaying the
status of an account on the Chart of Accounts screen, the system first reads the G/L account record
to see if it includes an inactive date. It then compares the inactive date to the effective date of the
control group, and any accounts where the inactive date is less than the effective date of the control
group will show an Inactive status.

The Chart of Account screen also displays statistics of the number of General Ledger accounts for your
institution (or client number, if your institution has more than one client number set up in the General
Ledger system).

Once you find the account you want to use, double-click it and the system will automatically enter the
account in the appropriate fields on the Transaction Entry screen. You can continue clicking accounts,
and the system will enter the account number on the next line.

Updating Chart of Accounts

The Chart of Accounts screen is updated automatically by the system according to the information entered
in the Chart of Accounts Status box. The default refresh rate is 0 days, meaning the Chart of Accounts will
be updated each time a user accesses Transaction Entry in CIM GOLD, clicks the <Control Group Entry>
button, or refreshes the screen. 
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The Last Updated field displays the last time the system updated the Chart of Accounts, and the Next
Update field displays the next time the system will update information into the Chart of Accounts.

If you know a new account number has been added to the General Ledger system, and you do not want to
wait until the next update to load the account number, click <Update Now> and the system will upload all
account information from the General Ledger immediately.

A message (shown below) will be displayed warning you that updating the Chart of Accounts may take
some time. Click <Yes> and the system will update the Chart of Accounts.
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Filters

The Filters expander bar on the Transaction Entry screen allows you to search for and filter out transaction
information you want to review. This expander bar is found on both the Pending Items tab and the Posted
Items tab.

Filtering is especially helpful if you've imported a large file of transactions and need to find any errors that
need to be corrected before posting.

To expand the Filters, click the arrow  in the top corner above the word Filters. The Filters expander bar
will be displayed, as shown below:

The fields under Column match the configuration of the transaction entry.

If you know what information you are looking for, enter it in the Filter column next to the field in the Column
where that information should be found.

For example, if you were looking for the payee name of "Ed's Office Supplies," you could enter "Ed" in the
Filter column next to Payee. When you click <Apply Filters>, the system will display any matches to "Ed"
in the Payee field on the main Transaction Entry screen. 

The system can match partial words and numbers (e.g., "Offi" would find all references of office, official,
offices, etc.).

The following paragraphs describe the fields on the Filters expander bar:

Field Description

Column and Filter
Entry

The list of searchable items is dynamic and changes with each configuration. As
you change the configuration, so will the searchable fields. Enter the information
you want to search for in the Filter column to the right of the field.
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Field Description

Note: When doing a search on Amount, you can search for an amount range by
separating the two amounts by a colon (e.g., 12.34:56.78).

Include information
items

This box is reserved for future use¾it currently does not have any functionality.
Leave it checked.

Include warning items Checking this box will only show transactions that have a warning status
attached to them.

Include error items Checking this box will only show transactions that have an error status attached
to them.

<Apply Filters> Clicking <Apply Filters> will apply the selected filters you have entered. Any
matching information will be displayed in the list view on the Transaction Entry
screen. Note: When filters are applied the Filters expander bar color will change
to indicate that filters are in use, as shown below: 

<Clear Filters> Clicking <Clear Filters> clears all the filter options that you have entered, but it
does not reset the Transaction Entry screen. 

<Stop Filtering> Clicking <Stop Filtering> resets the Transaction Entry screen to its original
state, but it does not clear out any information you entered in the Filters
expander bar.
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Find Feature

You can find specific information in the Transactions list view (both on the Pending Items or Posted Items
tab).

To find information:

1. Right-click the list view and select "Find" or press <Ctrl> + F. The Find dialog box is displayed, as
shown below.

2. Type the data you are looking for in the Find what field.
3. Select the direction you want to the system to search for first in the Direction box. Possible options are

Up or Down. The system will search for all occurrences for the data, but it will first search in the
direction you indicate.

4. Click <Find Next>. The system will search the entire list view for any occurrences of the data. If the
data is found in more than one occurrence, click <Find Next> to view the next occurrence.
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Changing Client Numbers
If you have more than one client number set up in General Ledger, you can select which client number you
will be posting General Ledger transactions to. 

Note: You must establish the correct client number before accessing the Transaction Entry screen.

To access a client number:

1. From the File menu in CIM GOLD, select Change Client Number > General Ledger (or press <Ctrl>
+ <Shift> + G on your keyboard).

The Change Client Number dialog box is displayed, as shown below:

2. Select the client number you want to use from the list view, and then click <Change> (or just
double-click the client number).

The list view will close and the client number you selected will now be used in CIM GOLD. The list
will only show client number that exist on FPS GOLD's host computer.

For more information about client numbers, see section 3.1, Client Numbers, in the General Ledger manual
in DocsOnWeb.

https://secure.fps-gold.com/docsOnWeb/accounting/GeneralLedger/agl3s1.htm
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